
CHAPTER SIX

 Use of the CATSS database with the Accordance program

1. Background

The CATSS database, as well as the MT and LXX ‘text panes,’ can be
accessed with the aid of the Macintosh Accordance program, 1 as of 1998
without col. b of the Hebrew, and without the linkage with the CATSS
files of morphological analysis of the Greek and Hebrew words.
Nevertheless, the internal morphological analysis of Accordance
allows the user access to many of the data which otherwise would
have been obtained by a linkage between the main file of parallel data
and the morphological analyses of the CATSS database. Complete
listings of individual Greek and Hebrew words can now be provided
with the aid of the internal Accordance predetermined lemmas
(morphologically and lexically tagged) and can be displayed
accordingly with or without the context of the verse. In this way all
the individual words of the Hebrew and Greek Bible can be concorded
with their equivalents in the other language. Furthermore, the
grammatical analysis and the search possibilities of Accordance allow
bilingual grammatical searches.

At the word level alone, the new type of concording retrieves much
more information than HR, as that tool does not include all the Hebrew
and Greek words. Thus, the user now has access to all the equivalents of
such Greek particles as dev and ajllav and of all the Greek pronouns, and
in these cases the Hebrew parallel data are available as well. The
Accordance program further avoids the various pitfalls of HR’s
recording system (cf. TCU, 90–99), and it can execute searches of parts of
Hebrew or Greek words, such as Hebrew prefixes and suffixes and Greek
preverbs.2 Beyond HR, Accordance enables searches of combinations of
words and of grammatical categories (see below). In the MT and LXX
‘text panes’ of Accordance  (but not in the MT/LXX file) searches can be
executed on any text unit in the LXX or the Hebrew Bible (all of the
LXX, one or more biblical books, or any combination of verses). Searches
can also be conducted on the comments in CATSS in the Greek and

                                                                        
1 Thanks are expressed to Roy Brown, the programmer of Accordance, and to F. Polak for

improving my description of this tool.
2 Words prefixed by -b are searched for in the MT/LXX tool with the use of a ‘wild card’

according to the sequence of the Hebrew as: ? <within 2 words> b.
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Hebrew text relating to translation technique, the relation to the
Qumran scrolls, and underlying Hebrew variants.

Accordance furthermore provides the user with brief standard
equivalents (not always reliable) in English of all the words in the
Hebrew and Greek texts. This information is provided in the text files
by placing the pointer on the text word. The lexical box at the bottom of
the screen provides the Hebrew or Greek text word together with the
lemma word and its brief morphological analysis (thus by clicking on
rmayw in MT, the lexical box provides the different English
equivalents of rma as well as their morphological analysis). More
extensive lexical information can be culled from entries in LSJ and the
LXX lexicon of Lust-Eynikel-Hauspie3 for the Greek words and in BDB
for the Hebrew words. This information is provided by first selecting
the word  in MT, and by subsequently selecting a lexical source (BDB,
LSJ, or the LXX lexicon) in the Amplify Palette, usually on the right
side. The program usually makes the correct connection between the text
word in the running text of MT and the entries in BDB. Thus if axwt in
axwtw is selected, the relevant entry of axy in BDB is displayed. This
search can also be applied to the MT/LXX text, but as the Hebrew in
that text is not connected with an underlying morphological analysis,
often the wrong entry from BDB is displayed.

In Accordance, lexical searches can be executed on the Greek (LXX1)
or Hebrew (HMT) text panes separately or on the MT/LXX tool (=
CATSS). The principles guiding these searches in the text files are:

a. Words can be selected from the text and placed in the search box.
b. Words can be defined in the search box.
c. Words can be called up from the list of predetermined words, in

the Options box in the main menu, under Enter Lexical Forms (e.g. grh)

or Inflected Forms (e.g., ytgrh).
d. Complex searches can be performed in the Construct window.

The principles for these searches are more or less identical when
searching in MT, LXX, or the combined MT/LXX tool, but in the latter
text (treated by Accordance as a tool, rather than a text) the options
are more limited as it is not linked with the list of predetermined
lemmas.

The following files may be opened:
a. the MT/LXX tool (the parallel alignment of CATSS without col.

b) by selecting the appropriate item from the New Window Palette,
usually on the upper right side. Alternatively this text can also be
opened by clicking on the ‘Open...’ item in the Edit menu.

b. MT (HMT), reflecting codex L.
c. the LXX (LXX1), reflecting the edition of Rahlfs.

                                                                        
3  J. Lust, E. Eynikel, and K. Hauspie, A Greek-English Lexicon of the Septuagint, I-II

(Stuttgart 1992, 1996).
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d. any combination of these text panes, or a combination with one of
the English translations, SP, or the Vulgate. Within Accordance all
these texts are linked, so that they can be scrolled down together,
always showing the same verse in Hebrew/Greek, Hebrew/English,
MT/SP, etc. as the first item on the screen. Also dissimilar texts can be
linked with the ‘Tie To’ command. Any second text can be added to the
first one by selecting the appropriate file in the menu File, New Text
Pane (e.g., HMT + SP or HMT + MT/LXX) or by selecting them
separately. Subsequently the ‘Tie To’ command in the Windows menu
should be invoked in order to link these dissimilar files.

The texts are presented as complete verses, and not as individual
words as in the CATSS database. The combination of the MT (HMT)
and LXX (LXX1) text panes is very significant in the perusal of
Accordance, as the separate Hebrew and Greek files allow for more
search possibilities than the MT/LXX tool.

Beyond the general equivalents of verses in the MT and LXX text
panes, Accordance also provides equivalents at the level of individual
words (lines in the CATSS database), by using the MT/LXX tool. The
sophistication of Accordance allows the user many possibilities short of
a full morphological analysis, so that the lack of the CATSS
morphological analysis of Greek and Hebrew is felt less. Furthermore,
by using the ‘Tie To’ command, the HMT and MT/LXX text panes can be
combined, so that the morphological analysis of the HMT text pane can
be used in order to show  the complete MT/LXX contexts in the parallel
window. The same possibility also exists in the reverse direction: single
equivalents can be called up in the MT/LXX tool, while the full context
can be viewed in the parallel window in the text pane of either the
HMT or LXX.

2. Principles of search in the lemmatized Hebrew and Greek texts

i. Word searches

The principles of searching words or forms in the two types of text files
differ, because the text panes of MT (HMT in Accordance) and LXX
(LXX1) use predetermined lemmas (morphologically and lexically
tagged), while the MT/LXX tool is not lemmatized, and hence its
search options are limited.

Searches in the HMT and LXX1 text panes are executed by opening
these texts and by filling in the word in the search box as described
above (the Search mode itself is activated by first clicking on Mode). In
this search Hebrew vocalization and Greek accents are disregarded, so
that the results refer to the Hebrew consonants or Greek letters only. A
simple search thus often produces more items than asked for. This
limitation pertains to nouns, adjectives, and particles, and to a lesser
degree to verbs. However, by combining data from different sets of
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information within Accordance, specific searches can nevertheless
usually be performed, with the exception of the search for some
homographs (Hebrew words belonging to the same grammatical
category, such as rb,d;, and rb;d;). Thus a search 4 for the three
consonants rbd can be accompanied by the definition Noun in the Tags
menu (in this case referring to both rb,d, and rb;;d;, but in most other
cases referring only to a single noun)5 or Verb. In the case of Greek
homographs, en can be defined as either Preposition (producing a list of
occurrences of ejn) or Adjective (producing a list of occurrences of eJn). This
amplified description is obtained by combining the regular search with
the possibilities provided by the Tags menu. In this way tailor-made
searches can be conducted for specific verbs or nouns. Thus present tense
forms of levgw can be searched for as levgw@[VERB present]. The
optimum for this search is obtained by opening both the HMT and LXX1
text panes (with the aid of the New Text Pane menu). This procedure
enables the scrolling down together of the two text panes. The
combination of these two text panes is needed, as the MT/LXX tool
cannot be used directly with the grammatical tags.

An example of a complex search of data which cannot be accessed
with the extant printed research tools is the search for any combination
of two or more words such as yp l[ (hp l[).6

The following issues should be considered as well:
1. Searches for the Greek base forms, such as kuvrio" for the noun or

e[rcomai for the verb automatically list all inflected forms as well, thus
including kurivou, etc. for kuvrio" and such forms as ejleuvsh/ and h[lqosan for
e[rcomai.

2. Searches can be conducted on any combination of Hebrew and Greek
characters, including ‘wild cards,’ as explained in the Accordance
manual. Wild cards for single characters are indicated by ‘?’. Thus in
the LXX text pane a search for ot? will produce listings for both o{ti and
o{te. Likewise, a wild card in the middle of word refers to any single
letter. Thus r?b will list any Hebrew word starting with a beth and
ending with a resh, with a single letter in the middle. The slash
separating between morphemes in the database itself (e.g., h/l) is
disregarded in this search.7

3. The wild card * refers to any number of letters. The search of
*ercom* (with a star at both ends) provides all the inflected forms of
                                                                        

4 The search alphabet is based on the transcription alphabet of the CATSS database.
Thus in Hebrew a = A, b = B, g = G, etc., and in Greek, a = A, b = B, g = G, etc.

5 In this search, Accordance provides the results for the following items under rbd,
which cannot be distinguished: word, plague, pasture, Debir, Debar.

6 This search yields the following results for the LXX: dia; rJhvmato" (3 x), dia; prostavgmato"
(8 x), dia; fwnh`" (10 x), ejk (1 x), ejpiv (6 x), ejpi; stovmato" (4 x), ejpi; stovma (1 x), ejpi; tw`/ stovmati
(2 x), kaqavper (1 x), katav (3 x), kata; ta; eijrhmevna (1 x), kata; stovma (1 x), metav (1 x).

7 This implies, for example, that for this type of search y/tyrb consists of four letters
only when the search refers to t?rb or ?yrb.
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that verb, including preverbs (ejxevrcomai, prosevrcomai, etc.), and
including inflected forms which have no consonants in common with
ercom, such as ajpeleuvsh/ and dihvlqwmen.

4. In the Construct panel the same results can be obtained without
the use of stars: When the Greek text is displayed, one should select in
the File menu New Construct, Greek. LEX is placed in the bottom left
window, together with ercomai from the list of lexical forms. The search
is then started after the two windows are first linked with LINK in the
Options menu under Enter Commands. In the same way all infinitives of
this verb can be listed by listing ‘infinitive’ in the space under the
Greek verb, or all non-infinitive forms by selecting the NON box for the
infinitives. In a similar way all occurrences of ˚lh can be concorded in
the Hebrew construct window, starting with the bottom right window.
Or, all forms of the type [snb are concorded in the New Construct
window as a combination of the LEX form b and VERB, inf. constr.,
combined by the command WITHIN 1-1 words.

5. Combined searches can be extended to more than one item
(commands: AND, NOT, FOLLOWED BY, PRECEDED BY, OR). Thus,
use of the AND command (Options: Commands) allows the user to find
all verses in which levgw and kuvrio" occur together, or all verses in
which forms of levgw are immediately FOLLOWED BY kuvrio". The
same pertains to more complex searches such as ou{tw" <WITHIN 2
Words> levgw <WITHIN 2 Words> kuvrio".

6. Secondary searches on the results of initial searches can be
executed with the aid of the CONTENTS command in the OPTIONS
menu. In the last mentioned example in paragraph 4, many equivalents
of the combination of b and the inf. constr. are provided, which can be
tabulated further. If from this list the equivalent o{ti is singled out, the
following procedure needs to be followed after the initial results have
been concorded: another search menu needs to be opened (FILE, NEW,
SEARCH WINDOW). In this search window, write ‘o{ti <AND>
[CONTENTS SEARCH],’ both to be selected from the OPTIONS,
COMMANDS.

ii. Grammatical searches

Accordance includes an analysis of all the Greek and Hebrew words
defining each of these words grammatically (e.g., for yr’b;D“: noun,
plural, masculine, construct). The program allows for a search of all the
words belonging to a specific grammatical category. Thus the user can
ask for all nouns, or more in detail, all plural nouns, or in still greater
detail, all plural masculine nouns, or all plural masculine construct
nouns (such as yreb]Di), etc. These searches can be executed with or
without the equivalents in the other language. After the Hebrew or
Greek text is chosen, the search can be performed on any of the
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grammatical categories listed in the Tags menu. At a second stage the
parallel Hebrew or Greek text can be linked to the results of this
search, so that all the bilingual contexts are presented.

The Hebrew tagging allows, i.a., for a specialized search of forms
with a directional he, paragogic he (both under ‘suffix’ in the Tags
menu), infinitive absolute forms of the Hebrew verb, construct nouns,
dual forms of nouns, relative and interrogative pronouns, suffixes,
conjugations of the Hebrew verb, etc. Tagging of the Greek allows for
similar searches, such as a specific tense or aspect of the Greek verb.
Thus, the frequency of the aorist optative can be researched in this
way.

Special searches can be executed by combining specific Greek or
Hebrew words with grammatical categories. In the Construct window
these searches can be combined with various commands such as NOT
(under the word searched, not next to it), WITHIN, INTER, AGREE (all
in the central box). In this way one can list, for example, proseuvcomai
FOLLOWED BY ‘Noun’ in order to examine the rectio  of that verb.  The
subjunctive forms of the verb not preceded by ouj or mhv can be listed in
this way (Accordance User’s Guide, 9.8). 8 The construction ejn +
infinitive (actually = ejn + tw`/ + inf.) can also be concorded in this way,
with or without elements intervening between ejn and tw`/ (Accordance
User’s Guide, 9.9). The latter search is executed by writing ejn in the left
box, followed by ‘VERB, infinitive’ in the adjacent box and below
WITHIN (1-2 words) in the central box. In another instance, examples
of qeov" without an article within five words before the noun are listed
(Accordance User’s Guide, 9.14). 9  By the same token all entries of rma
or rbd which are NOT verbs can be concorded.

3. Principles of search for the unlemmatized MT/LXX tool

Words in the unlemmatized MT/LXX tool (= CATSS) cannot be accessed
with the same sophistication as the separate LXX and MT text panes.
However, some simple searches can be executed by searching for strings
of letters in either language.

These searches are executed in the MT/LXX tool by locating
equivalents either in the context of a complete verse or as individual
lines of the CATSS database. For this purpose, in the MT/LXX tool, the
box Entry is opened and either ‘Hebrew’ or ‘Greek’ is selected in this
box. Subsequently a Hebrew or Greek word or combination of letters in
the text is selected and copied in the search box. Alternatively any
combination of letters can be written in the search box. Subsequently,
the results are displayed in lists of individual equivalents in the

                                                                        
8 Central box WITHIN, left bottom box ouj, mhv, crossed out by NOT, and adjacent box:

VERB, subjunctive.
9 Central box WITHIN, left bottom box ‘art.’ crossed out by NOT, and adjacent box qeov".
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MT/LXX tool or of lists of such equivalents within their context of the
complete verse. For the first line on each screen the text reference is
provided in the reference box. The results of the search for l[ includes

such forms as y/l[, ˚y/l[, but not l[b or l[n, so that the results
form a reasonable basis for research, although inferior to the results
obtained in the separate LXX or MT text panes. On the other hand, the
results include the parallel elements in the other language.

In the Hebrew text in the MT/LXX tool, the different morphemes are
separated by a slash. These slashes are treated as word separators, so
that a search for arby/w should be phrased as

arby <WITHIN 2 WORDS> w.
In the MT/LXX tool, the results are listed for the database as a

whole, and cannot be subdivided into individual books of the Bible.

i. Special searches and notations

Special searches include an analysis of all paragraph divisions in the
MT text (p or s) which can be searched in the HMT text pane.
In the CATSS database, special notations refer to select categories in
translation technique and other data. Searches of these notations can be
made on all the special notations in the Hebrew and Greek columns of
the CATSS database, relating to the translation character of the LXX
and its relation to the Qumran scrolls, as well as textual variations.
These searches can be executed in the MT/LXX tool, in the ‘Entry’ box
under Comments. A search for ‘?’ lists all these comments according to
the sequence of the text. Specific details which can be searched for
include:

c = {c} conjectures in the Greek text
d = {d} doublets   
d = {..d} distributive use in the translation
p = {p}, {..p} difference between MT and LXX in particle/

preposition
r = {..r} element repeated in the translation
s = {s} superlative
t = {t} transcriptions
nd, ad ,nad, v, etc. subdivisions in the renderings of inf. constr.

denoted as {!}nd, etc.
sp = <sp> agreement between the LXX and SP against MT
q = <q4b> agreements with Qumran scrolls, in this case

relating to 4QNumb

.yw interchange between yod (MT) and waw (LXX),
etc.

.m metathesis

.y- the LXX omits a yod

.j the LXX joins two words
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At this stage the following important components of the CATSS base
elements cannot be searched for: .  {  ---  --+  !. The next release of
Accordance  will address these issues.

ii. Special display

The Amplify Palette in the top right corner of the text panes allows for
special presentations of the search results:

1. The ‘Plot’ option provides a graphic chart displaying the results
of the search data according to book and chapter. For example, this
presentation enables the user to see graphically in which chapters in
Genesis the hiph’il forms of the verb are found, and in which chapters
and books in the Torah hd[ occurs. The ‘Table’ option provides the
actual numbers of occurrences in each of the biblical books.

2. The ‘Analysis’ box, to be used in conjunction with the ‘Analysis
display’ in the Options menu, lists the individual searches alpha-
betically, a feature which is of help in grammatical analyses.

3. Under ‘Parsing’ the morphological information for each of the
words is provided.

4. The box ‘Old Testament’ provides parallels from the books of the
Hebrew Bible, if extant.

5. The box ‘Speech’ activates the speech representation of any
element on the screen, in English, Greek, or Hebrew, including the
recitation of the complete Bible text, or the parallel alignment of
CATSS.


